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Overview 
This guide provides agents and certified enrollers steps for delegating, de-delegating, and transferring 
Consumer Cases or Book of Business (BoB). 
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Background 
This guide is for Level 1 and Level 2 Agents, Agency Managers, and Approved Admin Staff, and for 
Certified Enrollment Counselors (CEC), Entity Managers, Plan Based Enroller (PBE), and Medi-Cal Managed 
Care Plan Enroller (MMCPE). 
 
Consumers can work with Counselors to apply for coverage. When a Counselor begins an application on 
behalf of the Consumer a delegation occurs automatically. 

Accept or Decline a Delegation Request  
The Counselor must accept the delegation to access the Consumer’s account or application. This section 
illustrates a Counselor’s perspective; however, Agents have similar functionality. The Counselor accepts 
a delegation request by following these steps: 

 Log into CoveredCA and select My Pending Delegations from the My Delegations dropdown. The 
My Pending Delegations list view displays. 
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 To accept a pending delegation request: 

• Select the checkbox next to the Consumer’s name and click the Accept Delegations button 

• Select the checkbox next to the Consumer Contact column label, and click the Accept 
Delegations button to accept all pending delegation requests. 

 
 To decline a pending delegation request 

• Select the checkbox next to a Consumer’s name, and click the Decline Delegations button 

The Consumer displays in the Counselor’s My Active Delegations list view on the Delegations page 
when delegation is complete. 

• Clicking a Consumer’s name link from the Consumer Contact column displays the Consumer’s 
Contact page 

• Clicking the Consumer Case link in the Quick Links section navigates the Counselor to the 
Consumer Home page 

 
• Clicking a link under the Delegation Name column displays the Delegation page with the 

functionality to Accept Delegation, Decline Delegation, and Mark as Inactive buttons 

 

Back to Table of Contents 
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Removing Delegation 
Agents can remove a Consumer from their Book of Business (BoB) on the Consumer’s Delegation page. 
This section illustrates the steps from the Agent perspective; however, Counselors have similar 
functionality. To remove a Consumer from an Agent’s Book of Business: 

 Select My Active Delegations from the My Delegations dropdown. The My Active Delegations list 
view on the Delegations page displays. 

 
 Click a link from the Delegation Name column. The Delegation page displays. 

 
 Click the Mark as Inactive button.  
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• The Mark as Inactive popup displays. Click the Save button. The Consumer is removed from 

the Active Delegations list. 

o Clicking the Cancel button navigates the Agent back to the Delegation page 

 
 

Back to Table of Contents 
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Delegation Tool  
The Delegation Tool provides a means for Agents and Counselors to self-serve and delegate a 
Consumer’s case to their BoB. Counselors, Agents, Entity Managers and Agency Managers access the 
Delegation Tool link from the Quick Links section on the Welcome to your Agency Home Page!. The 
following steps illustrate the process by which both Agents and Counselors access the Delegation Tool.  

To begin the delegation process, the Agent must first search for and identify the active Consumer.  

 
 Click the Delegation Tool link from the Quick Links section on the Welcome to your Agency Home 

Page!. The Consumer Delegation page displays.  

 

 Enter the following Consumer information on the Delegation Form: 

• First name 

• Last name 

• Date of birth  
 

The Does the Consumer have a Social Security number? section is optional and displays with a Yes 
and No radio button. The radio button defaults to Yes and displays the Social Security number (SSN) 
field. 
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 Enter the SSN. 
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• An error message displays when the SSN is not a nine-digit number 

• Clicking the No radio button in the Does the Consumer have a Social Security number? field 
displays the following and requires at least one search criteria option: 

o A message: You must provide at least one of the following search criteria before you can 
proceed with delegation displays 

 
o Search criteria options: Home Address, Cell Phone Number, or Email Address. An Add 

button displays next to each option 

o Selecting an option dynamically displays a required entry field 

o Clicking the Remove button removes the selected search option 

Note:  Searching by Home Address is recommended.  

 Check the box next to each statement in the Consumer Consent to Delegate Case to [Agent’s name] 
section to indicate that the Consumer consents to the Agent to act on their behalf.  

mailto:OutreachandSales@covered.ca.gov


Delegating and Removing Delegation 
Task Guide 

 
 

Covered California | Outreach and Sales Division 
OutreachandSales@covered.ca.gov Page 8 of 20    May 3, 2023 

• An error message displays when a checkbox is unchecked  

• Clicking all the checkboxes enables the Check for Consumer button 

 

Note: Clicking the Cancel button navigates the Agent to the Welcome to your Agency Home 
Page! 
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 Click the Check for Consumer button to initiate a search based on the criteria entered. The system 
conducts a match based on the information entered. One of the following displays: 

• No Match Found – No existing match found in the system 

 
o The Return to Enroller Dashboard button navigates the Agent to the Welcome to your 

Agency Home Page! 

o The Start Over button navigates the Agent to the Consumer Delegation page 

• Multiple Matches Found – Multiple matches found in the system  

 
• Match Already Delegated – Match found and is currently delegated to the Agent 
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The next step in the delegation process is to authenticate the Consumer. The One Match Found page 
displays when an exact match is found. 

 

 On the One Match Found page enter the Consumer’s cell phone in the cell phone number fields.  

 Check the SMS Terms Of Service checkbox to continue.  
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 Click the Send One Time Authentication Code button. A code is sent to the cell phone number 
entered. 

• Up to three authentication codes can be requested. The user has three attempts to 
successfully enter each code 

• A total of nine attempts with the incorrect code disables all fields except for the Return to 
Enroller Dashboard button  

 
Note: The authentication code becomes invalid after 15 minutes and when the page is 
closed. Clicking the Cancel button navigates the user to their respective home page. 

 Click the Submit button on the One Match Found page. One of the following popups displays: 

• The delegation process was successful – Consumer’s case is successfully delegated  

 

• The delegation process was unsuccessful – Due to a system error popup displays  

 
Back to Table of Contents 
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Approved Agency Admin Staff Level 1 and Level 2 
Approved Admin Staff Level 1 and 2 may delegate a Consumer on behalf of an Agent. The Admin Staff 
first conducts a search for an active Agent and accesses the Agent’s Contact page before continuing with 
the delegation process. 

 Select Team List from the My Team dropdown menu on the Welcome to your Agency Home Page! . 
The My Agency Enrollers list view on the Contacts page displays. 

 
 Enter one of the following search criteria in the Search this list… field: 

• Name 
• Enroller License Number 
• Email 
• Phone 
• Certification/Approval Status 

 
 Select the desired delegate by clicking on the link associated to the Agent from the list of names 

displaying under the Name column. The Agent’s Contact page displays. 
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 Click the Delegation Tool link in the Quick Links section. The Consumer Delegation page displays. 

 The Admin Staff completes the delegation process similar to all other users. 

 
Back to Table of Contents 
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Transfer Consumer Delegations  
Agency Managers and Entity Managers can transfer a user’s entire BoB or specific Consumer cases from 
one user to another user within their Agency or Entity on the Transfer Delegations page. Additionally, 
Agency Admins and Entity Admins can transfer an entire BoB from one user to another user across 
different Agencies and Entities on the Transfer Book Of Business page. The section is written from the 
Agency Manager’s perspective; however, Entity Managers have the same functionality.  

To transfer an Agent’s entire BoB: 

 Select Transfer Delegations from the Agency dropdown on the Welcome to your Agency Home 
Page! The Transfer Delegations page displays. 

 
 Select the Transfer all delegations from one enroller to another enroller radio button 

 Click the Next button. 

• Clicking the Cancel button navigates the user back to the Welcome to your Agency Home 
Page!.  
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 Search for the Agent whose BoB is being transferred using the Search field on the Select the source 
enroller for the delegation transfer page. Agents may use the following parameters to search: 

• Name 
• Email 
• License/Certification Number 
• Role 

 

 Select the checkbox next to an enroller’s name. 

 Click the Next button. 

• An error message displays when more than one enroller is selected 

• Clicking the Cancel button navigates the user to the Transfer Delegations page 

 Search for an Agent to receive the BoB transfer using the Search field on the Select the target 
enroller for the delegation transfer page. Agents may use the following search parameters: 

• Name 

• Email 

• License/Certification Number 

• Role 

 Select the checkbox next to an enroller’s name. 
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 Click the Transfer Delegation(s) button. 

 
Note: Only enrollers in Certified and Active status can receive delegation transfers. error message 
displays when an enroller does not have these statuses.  

 

A message displays that the transfer is in progress. Clicking the Return to Home Page button navigates 
the user to the Welcome to your Agency Home Page!. 
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A Delegation Transfer Status popup displays with a successful message. 

 

Note: The Delegation Transfer status displays an error when the transfer is not successful  

The steps illustrated above to transfer specific case(s) between Agents are identical for an Agency 
Manager. 

Back to Table of Contents 

 

Exporting an Agent’s Book of Business 
The Welcome to your Agency Home Page! includes an Agency Book of Business tab which displays the 
Book of Business by Enroller Contact report, allowing Agency Managers to search for an Agent and 
export their BoB. The section is written from the Agency Managers perspective; however, Entity 
Managers have the same functionality.  

To export an Agent’s BoB: 

 From the Welcome to your Agency Home Page!, click the magnifying glass icon to display the Search 
report table field to search for the enroller. 
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Note: Clicking the Filter icon displays the Filters menu to filter the list of enrollers. 

 Select the checkbox next to the enroller’s name.  

 Click the Edit dropdown arrow and select Export.  

• The Export popup displays with the following export view options: 

 

• Formatted Report: Export the report, including the report header, groupings, and filter settings 

• Details Only: Export only the details rows. Use this to do further calculations or for uploading 
to other systems 

o Selecting the Details Only tile enables the Format dropdown, and an Encoding field 
displays. 

 Click the Export button. The Book of Business by Enroller Contact report downloads to the user’s 
local computer and displays in an excel file. 

 
Back to Table of Contents 
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Exporting Your Own Book of Business  
In addition to exporting a specific Agent’s Book of Business, Agency Managers and Entity Managers can 
export their own BoB. Agents, and Counselors may also export the BoB using the same steps illustrated 
above with one minor difference: clicking the My Book of Business tab on the Welcome to your Agency 
Home Page!, the My Book of Business report displays. 

 
My Delegation History  

The My Delegation History list view on the Delegation History page displays the Agent’s or Counselor’s 
delegated Consumers when the delegation process is successful. This section is intended for Agency 
Managers; however, Entity Managers, Agents and Counselors have the same functionality.  

 Select the My Delegations tab dropdown. 

 Select the My Delegation History link.  
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The My Delegation History list view on the Delegation History page displays with the following 
Consumer information: 

• Consumer Contact 
• CalHEERS Case/Application ID 
• Delegation Start Date 
• Delegation End Date 
• Reason for End 
• Delegation History Name 

 
 

 Click the Delegation’s History Name link from the Delegation History Name column to display the 
Delegation History page. 

 
Back to Table of Contents 
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